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< SECTION 1: GETTING STARTED

Introduction

The Interactive Tutor Self-Assessment Software allows your students to
check their subject matter knowledge and understanding as they work
through their textbook. Now it’s easier than ever to give your students
the practice they need to improve their performance.

The software is the perfect complement for your textbook. As your stu-
dents begin to improve their understanding, they gain confidence in
their overall ability. Students can work at their own pace and check their
own work. Detailed reports and graphs let you track their progress.

Using the software, you have the flexibility to control how the program
functions. Numerous options allow you to customize the program to
meet your particular classroom needs. Since the Interactive Tutor Self-
Assessment Software automatically scores and records results, you can
focus on teaching, not grading quizzes.

This user’s guide explains how to effectively use the Interactive Tutor
Self-Assessment Software. Section 1: Getting Started helps you install
the software and prepare it for use in your classroom. Section 2:
Working with the Interactive Tutor Self-Assessment Software provides
detailed information that describes how the software works. You will
find valuable tips that will help you and your students quickly master
the software. Section 3: Teacher Utilities focuses on the options avail-
able to you, the teacher. The Appendix includes troubleshooting infor-
mation that could be helpful if you experience a problem with the soft-
ware.

Interactive Tutor Self-Assessment Software Features

The Interactive Tutor Self-Assessment Software is designed to help your
students master the subject matter presented in your textbook. Both
you and your students will benefit from these innovative Interactive
Tutor Self-Assessment Software features:
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Easy Installation and Setup — Installing the software on a hard drive
or network requires only a few minutes. Step-by-step instructions
guide you through the entire process.

Teacher Preference Settings — The Interactive Tutor Self-Assessment
Software includes several options that let you control how the software
functions. Do you want to use the software for remedial work, assess-
ment, or both? Should students be allowed to repeat a quiz? You can
customize the software to meet your classroom needs.

Computerized Scoring — The program automatically scores all
quizzes and records your students’ performance results. The Interactive
Tutor Self-Assessment Software eliminates the wasted time spent
checking workbook activity sheets.

Teacher Utilities — The teacher options make it easy for you to man-
age the software. You can set the preferences, update student records,
and change the teacher password. With a few simple steps, you can
even print a comprehensive class report or graph.

Intuitive Graphical User Interface — The intuitive interface lets stu-
dents begin using the software immediately. You do not have to waste
valuable class time explaining how to use the program.

Overviews — The software includes an overview that explains the
important concepts presented in a chapter. Hyperlinks for glossary
words are included in the overviews where appropriate.

Feedback — The Interactive Tutor Self-Assessment Software provides
helpful hints if a student answers a question incorrectly. A student will
know immediately whether or not the response is correct and why.
After a student completes a quiz, the program displays the overall per-
formance results and a detailed report.

Glossary — Students have access to a comprehensive glossary while
working with the software. All of the key terms presented in the text-
book are included in the glossary.
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Reports and Graphs — Comprehensive reports and graphs show your
students’ progress for every quiz. The Interactive Tutor Self-Assessment
Software includes a Performance Report and a Performance Graph.

Extensive Help — Context-sensitive help is available throughout the
Interactive Tutor Self-Assessment Software program. Instruct your stu-
dents to click the Help button any time they need assistance using the
software.

Preparing to Use the Software (Windows)

Review the following information before you begin using the Interactive
Tutor Self-Assessment Software. This information describes the system
requirements and explains how to install the software on a hard drive or
a network. After you complete the installation process, refer to the
instructions on page 8 for adding new student records.

System Requirements

Verify that your computer system meets the following hardware and
software requirements listed below.

e |BM PC (or 100%-compatible) computer

e color monitor

¢ high-density 3.5" disk drive and hard drive
e Windows 3.1 or Windows 95 (or higher)

e 4AMB memory

® mouse

e printer (optional, but recommended)

Installation Procedures

Follow these steps to install the Interactive Tutor Self-Assessment
Software. If you are using the software with multiple textbooks, install
each program separately. The setup program will automatically install
the software in the jtsa (or other specified) folder.

1. Turn on your computer.
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2. Insert the Interactive Tutor Self-Assessment Software installation
disk or CD-ROM in a drive.

3. Windows 3.1: While in the Program Manager, choose ARun from the
File menu.

Windows 95 (or higher): Click the Start button at the bottom of the
screen and choose the Run option.

4. Type a:\setup and press Enter to run the installation program from
a floppy disk. If you have a CD-ROM, replace the a:\ with the
appropriate disc drive (e.g., e:\setup.exe).

Follow the prompts on the screen. The installation program creates
the necessary folders and copies the files onto the hard drive. The
default folder is itsa.

5. Remove the installation disk from the drive.

Network Installation

The Interactive Tutor Self-Assessment Software is designed to run from
a network server. Before you begin the installation process, however,
make sure that you have the necessary access privileges. Additionally,
you will need write-access privileges to the program folder after you
install the software. Several of the Teacher Utilities menu options store
data in the program folder on the server. Your students must have read-
access privileges to the files in the program folder.

Follow the instructions below to install the software.
1. Turn on your computer.

2. Insert the Interactive Tutor Self-Assessment Software installation
disk or CD-ROM in a drive.

3. Windows 3.1: While in the Program Manager, choose ARun from the
File menu.

Windows 95 (or higher): Click the Start button at the bottom of the
screen and choose the Run option.

4. Type a:\setup and press Enter to run the installation program from
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a floppy disk. If you have a CD-ROM, replace the a:\ with the
appropriate disc drive (e.g., e:\setup.exe).

Follow the prompts on the screen.

5. Enter a destination folder (for example, x:\courses\itsa\history). The
installation program creates the necessary folders and copies the
files onto the network server.

NOTE: If the setup program indicates that the specified folder is
invalid, use File Manager or Windows Explorer to create a new fold-
er. Then try installing the software again.

6. Remove the installation disk from the drive.

7. At each computer, create a program start-up icon. Performing this
step provides the computer with the necessary information so that
your students can easily access the software.

Windows 3.1: Create a new program group called Interactive Tutor
Self-Assessment Software. Then create a new program icon. Use
the Browse button to identify the location of the program on the
network server. Click the Change Icon button and choose a start-
up icon.

Windows 95 (or higher): Click the Start button and choose Taskbar
from the Settings menu. Choose the Select Menu Program tab
and click the Add button. Use the Browse button to identify the
location of the program on the network server. Proceed to the next
screen and create a new folder called Interactive Tutor Self-
Assessment Software in the Programs folder unless you have
already installed other versions of the software. On the next
screen, enter a shortcut that includes the program name and book
name (for example, ITSA-American History). Indicate that you are
finished. Your students can now click the Start button to access
the Interactive Tutor Self-Assessment Software through the
Programs menu.

Startup Instructions

Follow these steps to start the Interactive Tutor Self-Assessment
Software.
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1. Turn on the computer.

2. Windows 3.1: Locate the Interactive Tutor Self-Assessment
Software program icon for the appropriate textbook. Double-click
the program icon to start the software.

Windows 95 (or higher): Click the Start button in the lower left cor-
ner of the screen. Highlight the Programs menu and locate the
Interactive Tutor Self-Assessment Software folder. Select the
appropriate textbook from the list to start the program.

3. Click on the splash screen to display the Student Registration dia-
log box.

If the Main menu already appears on the screen, choose the Open
Record option from the File menu to display the Student
Registration dialog box.

Preparing to Use the Software (Macintosh)

Review the following information before you begin using the Interactive
Tutor Self-Assessment Software. This information describes the system
requirements and explains how to install the software on a hard drive or
a network. After you complete the installation process, refer to the
instructions on page 8 for adding new student records.

System Requirements

Verify that your computer system meets the following hardware and
software requirements listed below.

e PowerPC Macintosh

e color monitor

¢ high-density 3.5" disk drive and hard drive
e System 7.5 (or higher)

e 3MB available memory

® mouse

e printer (optional, but recommended)
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Installation Procedures

Follow these steps to install the Interactive Tutor Self-Assessment
Software. The setup program will automatically install the software in
the Interactive Tutor Self-Assessment Software (or other specified) fold-
er.

1. Turn on your computer.

2. Insert the Interactive Tutor Self-Assessment Software installation
disk in a disk drive.

3. Double-click the installation program icon.
4. Indicate the folder where you want to install the program.

Follow the prompts on the screen. The installation program creates
a folder called Interactive Tutor and another folder inside it (for
example, American History-Early Years). Then the installation pro-
gram copies the necessary files to the hard drive.

5. Remove the installation disk from the drive.

Network Installation

The Interactive Tutor Self-Assessment Software is designed to run from
a network server. Before you begin the installation process, however,
make sure that you have the necessary access privileges. Additionally,
you will need write-access privileges to the program folder after you
install the software. Several of the Teacher Utilities menu options store
data in the program folder on the server. Your students must have read-
access privileges to the files in that folder.

Follow the instructions below to install the software.
1. Turn on your computer.

2. Insert the Interactive Tutor Self-Assessment Software installation
disk in a disk drive.

3. Double-click the installation program icon.

4. Indicate the server and folder where you want to install the pro-

gram.
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Follow the prompts on the screen. The installation program creates
a folder called Interactive Tutor and another folder inside it (for
example, Network Server: Interactive Tutor: American History).

Then the installation program copies the necessary files to the net-
work server.

5. Remove the installation disk from the drive.

Startup Instructions

Follow these steps to start the Interactive Tutor Self-Assessment
Software.

1. Turn on the computer.

2. Locate the Interactive Tutor program icon for the appropriate text-
book. Double-click the program icon to start the software.

3. Click on the splash screen to display the Student Registration dia-
log box.

If the Main menu already appears on the screen, choose the Open
Record option from the File menu to display the Student
Registration dialog box.

Adding New Student Records

After you install the Interactive Tutor Self-Assessment Software, the next
step is to identify which students will use the software. Either you, the
teacher, can add the new student records, or your students can add this
information themselves. To add a new student record, you must enter
a first name, last name, class ID, and a password. The program also
requires that you identify the location of the data files.

IMPORTANT: If you installed the software on stand-alone computers
and you plan to store the student data on the local hard drive, you can
begin adding new student records immediately. However, you must
manually set the data location before adding records if you plan to store
student records on a network server. Refer to the instructions on page
20 in Section 3: Teacher Utilities to learn more about setting the data
location.
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Adding New Classes and Setting the Preferences

The Interactive Tutor Self-Assessment Software provides several options
that let you customize how the program operates. These preferences
control how your students interact with the program. For example, you
can specify whether a student may check to see if his or her responses
are correct. Other options determine whether or not a student may print
a report that shows the answers for incorrect responses.

Although you may change the software preferences at any time, you
should review these options before your students begin using the soft-
ware. A complete description of the preferences and step-by-step
instructions to change the settings are given on pages 18 and 22 in
Section 3: Teacher Utilities.

Software Support Center

Glencoe provides toll-free telephone assistance for teachers who experi-
ence difficulty while using our software or templates. Before calling for
assistance, please check the following:

e |s your computer working properly? Try some other software,
which you know is working, on the same computer.

e (an you repeat the problem? Does the problem occur at the
same point each time?

In order for the Support Center to help you as quickly as possible,
before calling for assistance have the following on hand:

e exact title and ISBN number from the disk label or package
¢ brand, model, and configuration of the computer you are using

e gystem version (Windows 3.1, Windows 95 (or higher), System
7.5, etc.) installed on your computer

The Glencoe Support Center toll-free number is 800/437-3715. You
may also contact the support center by E-mail at epgtech@mcgraw-
hill.com The Support Center is available from 8:30 A.M. to 6:00 PM.
eastern time. Please do not give this number to your students.
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& SECTION 2: WORKING WITH THE
INTERACTIVE TUTOR SELF-ASSESSMENT
SOFTWARE

This section explains how to use the Interactive Tutor Self-Assessment
Software. Instructions are provided for the following topics: beginning a
session, choosing a quiz, completing a quiz, printing reports and graphs,
and exiting/quitting the software. Most of this information is also
included in the online help system so that students can readily access
the required step-by-step instructions.

Beginning a Session

Instruct your students to follow these steps each time they start the
Interactive Tutor Self-Assessment Software. If you have not already
done so, you may want to add a new record for each student. Although
your students can perform this task the first time they use the software,
you may avoid some problems if you perform this step for them. (See
Adding New Student Records on page 8.)

To begin a session:
1. Turn on the computer. Start the software as described below.

Windows 3.1: Locate the Interactive Tutor Self-Assessment
Software program icon for your textbook. Double-click the program
icon to start the software.

Windows 95 (or higher): Click the Start button in the lower left cor-
ner of the screen. Highlight the Programs menu and locate the
Interactive Tutor Self-Assessment Software folder. Select the
appropriate textbook title from the list to start the program.

Macintosh: Locate the Interactive Tutor Self-Assessment Software
program icon for your textbook. Double-click the program icon to
start the software.

2. Click on the splash screen to display the Student Registration dia-
log box as shown in Figure 2-1.
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Fig. 2-1

Note: This manual shows only the Windows screens for American History:
The Early Years in the figures. The Interactive Tutor Self-Assessment
Software Windows and Macintosh versions are nearly identical. Also, all of
the textbook programs are very similar in appearance.

If the Main Menu already appears on the screen, choose the Open
Student Record option from the File menu to display the Student
Registration dialog box.

3. Highlight your name in the list and click the Open button.

If your name does not appear in the list, click the Locate button.
Then identify the location of your data file. For example, you may
need to use the Locate button if you store your information on a
data disk.

4. Enter your password.

NOTE: If you have not registered, use the New button to add a new
student record. Enter your name, class ID, and password. The
New button may not always be available.

Choosing an Exercise

The number of quizzes varies from chapter to chapter within each text-
book. A chapter may contain from one to six quizzes, although the typi-
cal chapter has three or four section quizzes.
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To choose an exercise:
1. Select a unit from the Main menu.

After you make your selection, the program displays another menu
that lists the chapters in the unit.

2. Select a chapter or the unit review.

If you choose the wrong unit, click the Previous button or press the
Escape (Esc) key to return to the Main menu.

3. Choose the section quiz you want and click the OK button.

4. Review the overview for the quiz you selected. Click the OK button
to continue.

Every quiz includes an overview. The Unit Review and Cumulative
Review quizzes typically do not include an overview.

5. Complete the quiz.

If you selected the wrong quiz, immediately press the Escape (Esc)
key or click the End button.

Completing a Quiz

Follow these instructions to complete a quiz.

To complete a quiz:
1. Select a quiz from the menu.
2. Review the overview.

3. Carefully read each question and enter a response. (See the sam-
ple question screen shown in Figure 2-2 on page 13.)

4. (Optional) Click the Check button to check your response
for each item unless this button is not available.

For those questions in which you type a response, you must cor-
rectly spell and capitalize each word; otherwise, the program will
indicate that the item is incorrect.

12 Interactive Tutor Self-Assessment Software User’s Guide
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Fig. 2-2

5. Click the Next button in the lower right corner to display the next
question. You can also use the Page Up (PgUp) and Page Down
(PgDn) keys to move between questions.

6. Complete the remaining items. You can skip an item and then
return to it later by clicking the Previous button.

7. When you finish a quiz, click the End button.

8. Review the results. Click the Print button to print the quiz report if
your teacher instructs you to do so. The report shows your results
and responses. Click the Menu button to return to the Quiz
Selection dialog box.

IMPORTANT: If you need a printout of your work, choose to print
now. After you click the Menu button, you will not be able to print
the quiz report.

9. Choose another quiz, or quit/exit the program.

NOTES:

(1) If you want a printout of your work, you must choose to print a
report immediately after you finish a quiz.
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(2) If you do not complete a quiz during a session, click the End but-
ton or choose the Exit (or Quif) option from the File menu.
Complete the quiz again next session.

Accessing Help

Extensive online help is almost always available while your students
work with the Interactive Tutor Self-Assessment Software. They can
access the help information by clicking the Help button or by choosing
Help from the menu. The program will automatically display the appro-
priate help topic, but a student may choose any topic from the Contents
screen. A search option is also included to find help on a particular
subject.

Printing Reports and Graphs

The Interactive Tutor Self-Assessment Software program includes
options to print a Performance Report and a Performance Graph.
Students cannot print a report while completing a quiz.

To print a Performance Report:
1. Choose the Performance Report option from the Reports menu.

2. Scroll through the report to view your results.

The report shows the first attempt score for each section quiz you
have taken. If you answer every question correctly on the first try,
your score would be 100%. If there are 10 questions and you
answer every question correctly on the first attempt except #3,
then your score would be 90% even if you then answer #3 correct-
ly on the second attempt.

Also included on the report are the chapter, unit, and overall quiz
averages. The chapter average is the average of the first attempt
scores for a chapter. The unit average is the average of all the
chapter averages including the unit review score. The overall quiz
average is the average of all of the unit averages including the
cumulative review score.
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3. Click the Print button to print the report.
4. Click the Gancel button when you finish viewing the report.
To print a Performance Graph:
1. Choose the Performance Graph option from the Reports menu.

2. Review your results.

The graph shows the unit averages (first attempt score average
and raw score average for each unit), cumulative average, and the
overall quiz average.

3. Click the Print button to print the graph.

4. Click the Gancel button when you finish viewing the graph.

Exiting the Software

When your students finish working with the Interactive Tutor Self-
Assessment Software, instruct them to follow these steps to exit (or
quit) the software.

To exit the Interactive Tutor Self-Assessment Software:

1. Choose the Exit (Windows) or Quit (Macintosh) option from the File
menu.

2. Store your data disk in a safe place if you save your work on a data
disk.

3. Leave the computer and monitor on unless instructed otherwise by
your teacher.

NOTE: If a student must end an Interactive Tutor Self-Assessment
Software session before finishing a quiz, the student will lose his or
her work. Most quizzes are very short so this should not be a prob-
lem. Instruct the student to complete the quiz again next session.
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< SECTION 3: USING THE TEACHER
UTILITIES

The Interactive Tutor Self-Assessment Software provides features to
customize the program, manage student records, and generate reports.
This section explains how to use the teacher utilities to perform these
and other tasks. The Teacher Utilities menu is shown in Figure 3-1.
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Accessing the Teacher Utilities

Follow these steps to access the Teacher Utilities menu.

1. Start the Interactive Tutor Self-Assessment Software.

2. Access the Student Registration dialog box.

3. Windows: Hold down the Alt key and click the Open button.
Macintosh: Hold down the Option key and click the Open button.

4. Enter the teacher password. (Use ITSAPROG as the teacher pass-
word unless you changed it.)
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After you enter the correct teacher password, the program displays
the dialog box shown in Figure 3-2.
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5. Choose to access the Teacher Utilities menu, or select the option to
print quiz answer keys.

Updating Class Information

Using the Update Class Information option you can add up to 14 new
classes, edit the various class settings, delete a class, or copy informa-
tion between classes. (See the Add a New Class window as shown in

Figure 3-3.)
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It is recommended that you set up your class records before any stu-
dents begin using the Interactive Tutor Self-Assessment Software.

For each class, you can set the following options.

Allow students to score items: This option controls whether or not a
student may use the Score Item button to check his or her work in a
quiz.

Allow students to repeat a quiz: A student may repeat any quiz if this
option is enabled. Each time a student repeats a quiz, the program
replaces the previous score with the latest results.

Allow student to view graded quiz: If this option is enabled, the pro-
gram will print all of the actual responses and the correct answers for
any incorrect items. When this option is disabled, the program displays
only the student's score.

IMPORTANT: The Interactive Tutor Self-Assessment Software allows
you to organize your students by class rather than have individual set-
tings for each student. If you change any information for a class, the
software automatically applies the new settings to all of the students in
the class.

NOTES:

(1) The various class settings (e.g., score quiz, repeat quiz, and view
grades) are stored in the itsa.cfg file in the classes folder (in the
ITSA folder). If you are not running the program from a network,
you can set up the classes on one computer and then copy the
itsa.cfg file to the classes folder on the other computers.

(2) If you want to maintain two or more groups of settings for the stu-
dents in your class, simply create multiple classes or class sections.
For example, create two classes (i.e., 101A and 101B) with different
settings. Then, assign your students to the appropriate class.

(3) If you created several classes but they do not appear in the list,
make sure that you did not rename the classes folder in the pro-
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gram folder. Rename the folder, or create the folder and manually
copy the itsa.cfg file into it if this folder does not exist.

(4) If the program is installed on a network, you must have full access
to the ITSA folder and its subfolders to add, edit, delete, or copy
class information.

(5) While you can use the Update Student Information option to remove
student records, you can also remove the files by deleting them with
the operating system.

Updating Student Information

The Update Student Information option allows you to add a new student
record, change a student's information (first name, last name, class ID,
and password), or delete a student record. Choose this option and then
click the New, Edit, or Delete button to perform the desired task. (See
Figure 3-4.)
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Changing the Teacher Password

The Change Teacher Password option allows you to change the pass-
word required to access the Interactive Tutor Self-Assessment Software
Teacher Utilities menu or print quiz answer keys.
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To change the teacher password:

1. Select the Change Teacher Password option from the Teacher
Utilities menu.

2. Enter the current password.
3. Enter a new teacher password.

IMPORTANT: Be sure to write the new password on a piece of
paper and store it in a safe place. You will not be able to access
the teacher utilities without the password.

4. Click the OK button to record the new password.

NOTES:

(1) If you are using several different textbooks with the Interactive
Tutor Self-Assessment Software, changing the teacher password
applies only to the version currently in use.

(2) Since the program saves the password in the program folder, you
must have the appropriate write-access privileges if the software
is stored on a network server.

(3) Unless the program is located on a network server, a new pass-
word is valid only on the computer you used to change the pass-
word.

Setting the Data Location

The Set Data Location option lets you identify the location of the stu-
dents' data files. Changing the data location is necessary only if you
want to store your students' records at a specific location on a network.

When a student begins a session, the program automatically searches
for all of the student records. Normally, these files are stored in the
students folder. However, you can configure the program so the soft-
ware looks in a different location for this information.

Suppose you want to store each student's record on a network server in
his or her own subfolder. If all of the student subfolders were located in
a folder called x:\courses\students\, you could specify this path as the
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new data location. The Interactive Tutor Self-Assessment Software
would look through all of the subfolders at this location. Each time the
program found a student record, it would add that student's name to the
Student Registration list.

Alternatively, you could create a master folder (for example, x:\cours-
es\itsa\history\) on a network server and store all of the students' files
in this one location. In this instance, you would set the new data loca-
tion to x:\courses\itsa\history.

To set the data location:

1. Choose the Set Data Location option from the Teacher Utilities
menu.

2. Enter the new data location for your students' files.

Remember that students must have the necessary access privi-
leges to store their data on a network.

3. (Optional) You can enable/disable the option to control whether stu-
dents can log in as a guest or create new records.

4. Click the OK button to record the new data location.

5. If files already exist in the old data location, manually move those
files to the new location.

NOTES:

(1) If you are using several different textbooks with the Interactive
Tutor Self-Assessment Software, changing the data location
applies only to the version currently in use.

(2) Since the program saves the data location information in the pro-
gram folder, you must have the appropriate write-access privileges
if the software is stored on a network server.

(3) The data location acts as a beginning point that the program uses
to search for files. It will automatically search through all subfold-
ers located within a specified path.
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(4) If the data location includes more than 200 separate student fold-
ers, you may notice a delay while the program searches for the
student records. If you notice a significant delay when a student
starts the program, you may want to place all of the student
records in a single master folder for each textbook (for example,
x:\courses\itsa\history). Then set the data location accordingly.

Generating Reports and Graphs

The Interactive Tutor Self-Assessment Software program includes sever-
al options that you can use to generate the following performance
reports and graphs: Student Reports, Student Performance Graphs,
Class Summary Reports, and Class Summary Graphs. Step-by-step
instructions to print these reports are provided in the help system
accessible in the software.

Student Reports

Use the Student Reports option to print performance reports for your
students. The program generates a report that is identical to the
Interactive Tutor Self-Assessment Software Performance Report your
students can print. An option is provided in the Teacher Utilities to save
you time if you want to print these reports instead of having your stu-
dents print them.

Student Performance Graphs

Use the Student Performance Graphs option to print performance graphs
for your students. This option prints the same graph that your students
can print. It is provided here for your convenience.

Class Summary Reports

The Class Summary Reports option allows you to print one comprehen-
sive report for all students or for those students in a particular class.
This reporting feature is especially useful if your students' records are
all located on a network server. You can print a complete report in just
a few minutes.

22 Interactive Tutor Self-Assessment Software User’s Guide



If your students use stand-alone computers and store their data on a
hard drive, you can still print a Class Summary Report at each comput-
er. The report would summarize the performance results for students
who use that particular computer.

Class Summary Graphs

The Class Summary Graphs option allows you to print a graph that
summarizes your students' performance results. The Class Summary
Graph shows the overall average (first attempt and raw score) for each
student. You can print a graph for all students or for a specific class.

Printing Quiz Answer Keys

Using a special teacher option, you can print the questions and answer
key for every quiz. You can use these reports to go over the quizzes in
class, or to provide them to your students if necessary.

To print a solution (answer key) for a quiz:

1. Access the Teacher Utilities.

2. After you enter your password, choose the Print Quiz Answer Keys
option.

3. Choose a quiz. Then click the Print button.

4. When you are finished, choose Open Student Record or Exit (Quit
for the Macintosh) from the File menu.

Network Considerations

The Interactive Tutor Self-Assessment Software can be installed and run
from a network server. However, you can use the network's resources
to print reports and store students' performance data even if you install
the program on individual computers.

If your computers are connected to a network, printing is handled auto-

matically. The program directs all reports to the specified printer, and

the software prints the student's name on all performance reports.
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The software is designed to allow students to save their work onto a
network server. By storing the performance data in one central location,
you can easily access your students' data to generate comprehensive
class reports and update preferences. Use the Set Data Location option
to specify a location on the network for students to store their data.
Preferably, you should set the data location before any students use the
software.

Another benefit of using a network is that you can use it to store class
information. This option is especially useful when you create or update
classes. If you install and run the program from a network server, all of
your students can access these files from one central location. On
stand-alone computers, you must copy the class information to each
computer.
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< APPENDIX: TROUBLESHOOTING

This appendix includes troubleshooting tips that may help if you experi-
ence problems using the Interactive Tutor Self-Assessment Software.

The answers do not print on a student report.

The preference options are initially set to print answers, but you can
turn this option off. Check the setting in the teacher utilities.

The fonts used for the overviews, quizzes, and reports do not
appear properly.

The Interactive Tutor Self-Assessment Software (Windows) requires the
following TrueType fonts: Arial, Times New Roman, and Courier New.
The Interactive Tutor Self-Assessment Software (Macintosh) version
requires Geneva, Courier, and Times. These fonts are usually installed
on a computer at the factory. If the fonts are not available, install them
on the computer.

A student forgets his or her password.

Use the Update Student Information option in the Teacher Utilities to
determine a student’s password. (See page 19 for instructions.)

The teacher password does not work or is not available.

A special password is required to access the Teacher Utilities menu.
The original teacher password is given in Accessing the Teacher Utilities
on page 16. However, this password is no longer valid if you changed
the password. If you forget the password, call the Software Support
Center for further instructions. (See page 9.)

The program does not correctly interpret a student’s typed
response.

The program does not accept misspelled words. Proper capitalization is
also required. For example, suppose that a student enters "great
depression" in response to an item, but "Great Depression" is the cor-
rect answer. The program will indicate that the response is incorrect
since the student did not capitalize the words.
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If a student’s response appears to match the answer, the student may
have entered an extra leading space as part of his or her response.

A student cannot repeat a quiz.

The initial preference setting allows students to repeat any quiz, but you
can turn this option off. Check the settings in the teacher utilities for
the class assigned to your students.

The Score Item button is not available for a quiz.

The Score Item button is initially enabled, but may be turned off. Check
the class settings in the teacher utilities.

The software displays an error message when a student attempts
to save his or her work.

Students must have the proper write-access privileges before they can
save their work to a network server. Initially, the program attempts to
save new student records in the program folder. Usually, students do
not have the proper access privileges to save data at the location used
to store the program. Either grant students the appropriate rights or
identify a different location for saving data. (See the instructions given
on page 20 for the Set Data Location option.)

New student records are not saved in the appropriate location.

By default, the Interactive Tutor Self-Assessment Software attempts to
save new student records in the program folder. Change the data path
using the Set Data Location option. (See page 20.)

The Student Registration dialog box does not display immediately
after the Opening Screen disappears at the beginning of a new
session. Or, the program takes several minutes to display the dia-
log box after a student chooses the Open Student Record option.

The default data location is set so that the program looks for the stu-
dent records in the program folder. The program searches the program
folder and all of its subfolders to locate student records. If you change
the data location incorrectly, the program may be searching the entire
hard disk, which could require several minutes. Check the data location
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setting and identify a more appropriate search path.

A message indicates that there is not enough memory to run the
program.

On Windows systems, close other applications to free additional memo-
ry. If the problem persists, make sure that the virtual memory option is
enabled.

On Macintosh computers, verify that you have at least 3MB free memo-
ry. Quit other applications before running the Interactive Tutor Self-
Assessment Software. If you get a low memory message while running
the program, use the Get Info Finder option to increase the memory
requirement.

What steps are required to remove (uninstall) the program?

Windows: Use File Manager or Windows Explorer to delete the
Interactive Tutor Self-Assessment Software files. If you remove the pro-
gram folder (e.g., \itsa) and its contents, you will effectively erase all of
the files. No other files are located on your computer, except if your
students’ data files are stored in a different location.

Macintosh: Drag the program folder (e.g., Interactive Tutor) along with
its contents into the Trash and then choose the Empty Trash option. If
you remove the program folder (e.g., HD: Interactive Tutor) and its con-
tents, you will effectively erase all of the files. No other files are located
on your computer, except if your students’ data files are stored in a dif-
ferent location.
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